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WinImage is a shareware product from an ASP member. You may copy it & distribute it as long as you do 
not charge a fee (You may charge a small fee to cover the diskette & shipping only) and distribute it in it's 
entirety (All of the files from the author).



What is a disk image ?

WinImage is a disk image management utility. A disk image is a file which contains all the floppy data 
(files, FATs, boot sector, directory...).

By making an image of a floppy disk and writing it to another, we get an exact copy (as with the DOS 
DiskCopy command). We can read a floppy and write the image on the hard disk. A day later, without 
using a floppy, we can extract a file from the image. A week later, we can write the image on two new 
floppies, for instance ( without needing the original), and create two exact copies of it.

We can also create disk images with WinImage. If we want to put 5 files (taking 1.3 Mb) on a 3"1/2 HD 
unformatted floppy, we create an empty 1.44 Mb image, inject the 5 files into it from the hard disk (this is 
very fast) and in one operation, we format the floppy and write the image on it.

WinImage can format and use very large-capacity non-standard disks. (3"1/2 HD 1.72 Mb and 5"1/4 HD 
1.44 Mb). To use them, you must load, before Windows 3.1, the TSR FdRead, a shareware program from 
Christoph H. Hochstätter which you can get with the FdFormat utility. I think that having a look at this is a 
must. You don't need this TSR if you use only standard formats with WinImage.

You can load an image by reading a floppy, reading an image file, or creating an empty image.

You can extract the files of an image onto any device. (hard disk, network unit, or floppy).

You can also add files to the image.
The image can be copied onto a floppy (which must have the same format), or saved in a file.

An image file contains all the floppy sectors. If it's not full, you can truncate it.

WinImage can read the images of a lot of disk copy utilities: Wimage (in FdFormat utility) from C.H. 
Hochstätter, CopyVit from Sébastien Chatard, DrDos 6 and OS/2 2.x diskimage utilities, DCF (Disk Copy 
Fast) from Chang Ping Lee, DF (Disk Image File Utility) from Mark Vitt, Super-DiskCopy from Super 
Software, SabDu from S.A. Berman, Disk-RW from K. Hartnegg, DiskDupe from Micro System Design, 
internal disk Microsoft and Lotus image utilities and the MFMT sample Windows NT application that 
comes with Windows NT SDK.



Using WinImage

In its main window, WinImage shows the files and directories present in the image. You can go into a 
directory by double-clicking on it. To return to the parent directory, double-click on the first entry ("..").

With WinImage, you can also open an .ISO CD-ROM image file, in read only mode.

WinImage runs with the image in memory. When there is no image, some icons and menu entries are 
greyed.

You can create a directory, delete or add files in the image with the icons or the Image menu. You can use
drag-and-drop from the Windows File manager to WinImage to inject data into an image, or from 
WinImage to another application to extract from it.

You can extract files in three ways: By extracting in the Image menu (or its icon), launching a file by 
double-clicking on it, or by dragging it to another application.

WinImage allows you to drag the image file from WinImage to another application: You put the mouse 
pointer in the status bar or in the toolbar background. You press the left mouse button and keep it 
pressed, put the mouse pointer onto another application (drag and drop client), and release the mouse 
button. This original function allows you to add the image in a .ZIP or .ARJ file with Nico Mak's WinZip 
utility, or attach the image to an e-mail created with Microsoft™ MS-Mail, or Lotus™ Notes or ccMail.

I am distributing the utility FDREAD.EXE, from C. Hochstatter, with the Intel version of WinImage. 
FDREAD is used for reading non-standard floppy disks while in DOS and Windows 3.1. FDREAD is not 
needed for WinImage operation under Windows 3.1. FDREAD has no effect under Windows 95 or 
Windows NT.

I suggest that you do not use the 820 KB or 1.72 MB formats, because they can not be read under 
Windows NT. I suggest that you use the DMF or the 1.68 MB format.



About DMF

DMF and 1.68 MB format are the same physical format. (80 tracks, 21 sectors/track). The 1.68 MB format
has 224 entries in the root directory, and a cluster size is 512 bytes. The DMF format has 16 entries in the
root directory, and the cluster size is 1024 or 2048 bytes. Microsoft uses DMF 2048 for the floppy version 
of some of their new software. Windows 95 and Windows NT 3.5x read and write directly in DMF format, 
and you will need FDREAD to read these files under MSDOS or Windows 3.1.

Some Microsoft DMF floppy disks contain information to make them write-protected under Windows 95 or
Windows NT 3.5x. To write to these floppy disks, you will need to reformat them.

The DMF 2048 format is often used for distribution floppies under Windows 95 and Windows NT. 
Under Windows 95, unlike other operating systems, formatting for DMF uses the BIOS. You can have 
compatibility problem on some computers. If you experience such problems, I suggest you try the 
following: 
- If your system has a flash BIOS, upgrade the BIOS to the latest release. If you have an Intel 
motherboard, you can find BIOS upgrades at ftp://ftp.intel.com/pub/bios.
- Format the floppy to 1.44 MB before trying DMF.
- Try to get more conventional memory (ideally by having a near empty config.sys) .
- Try using both winimage.exe and winima16.exe under Windows 95. (Ignore the message from 
winima16.exe that suggests not running using this O.S.) .
- download FDFormat (ftp://ftp.coast.net/SimTel/msdos/diskutil/fdform18.zip). Under DOS (or Windows 95
command line only without graphics interface - this is accomplished by pressing F8 and selecting 6 when 
booting) try 'FDFORMAT A: F168'. As is true with WinImage, FDFormat uses the BIOS. If FDFormat 
cannot format a disk at 1.68 MB, WinImage will also be unable to.

Some problems with DMF formatting under Gateway 2000 computers can be solved by downloading a 
BIOS update from the Intel FTP or web site (www.intel.com).

Under Windows 95, the following options are available In the Options Settings, Disk tab:

- If both Use new DMF format technology and Use new DMF technology for writing data also are 
checked, WinImage will use the new 3.0 DMF formatting code.
- If both Use new DMF format technology and Use new DMF technology for writing data also are 
unchecked, WinImage will use a slightly fixed version of the 2.5 DMF formatting code.
- If Use new DMF format technology is unchecked, WinImage uses the same code as version 2.20 to 
format (in fact, in WinImage 2.50, there was a bug, this checkbox didnt do anything)

Some DMF related problems can be corrected by adjusting the disk gap. To change this setting, you must
modify the registry. The key value to modify is HKEY_CURRENT_USER\Software\WinImage\iGapDmf. A 
value of "0" specifies the standard DMF GAP. One user needed "17" for a 2.88 driver. Please report any 
problems solved by modifying the GAP.



File Menu

New

Creates a new, empty image. You must select a format (for example: 1.44 Mb).

Open

Opens an image file.

Close image

Closes the current image.

Save

Saves the current image.

Save as

Saves the current image with a new name.

Batch Assistant

Opens the Batch assistant dialog box.

Exit

To quit WinImage.



Image Menu

Create directory

Creates a directory in the current image.

Select

Selects files in the current image.

Inject

Injects files into the current image.

Inject a directory

Injects a complete directory (and subdirectory) into the current image.

Extract

Extracts files from the current image.
If no file is selected, WinImage extracts all files from the image by default. Otherwise it extracts only 
selected files.
Depending on the Confirmation option, you will have to specify the extraction path. (a dialogue box with 
some Preference fields is shown).

Delete file

Deletes files from the current image, after asking for confirmation.
If there is no file selected, WinImage deletes all the files from the image by default, otherwise it deletes 
only the selected files.

Change Label

Changes the volume label of the current image.

Change size

Changes the size of the current image.
The new size must be greater than the total size of the files in the image. (You can transform a 1.44 MB 
image into a 360 KB image only if you have less than 360 KB of files).



Defrag current image

Defragments the current image files.

Image information

Shows information about the current image, and lets you edit the images comment.



Diskette Menu

Use drive A: or B:

Selects drive A: or B: to read and write floppies.

On a computer with two drives, this command lets you choose the unit you want to use for reading or 
writing disks.

Format disk

Formats a blank floppy.

Create CDRom Iso image

Creates and opens an ISO image file from a CD-ROM. This options requires Windows NT.

Read disk

Reads a floppy and store its image in memory.

Compare disk

Compares the current image with a floppy.

Write disk

Writes the current image to a floppy.

Format and write disk

Formats a floppy and writes the current image onto it.



Option Menu

Sort by Name
 Sort by Type
 Sort by Size
 Sort by Date

These options are used for displaying the file present in the image.

Font
Changes the current font (used for displaying the files present in the image).

Setting

Under Windows 95, Windows NT 3.51 or Win32s 1.30, all options are in one tabbed dialog box. Items in 
the dialog boxes are the same as in Options, Confirmation and Sound & notification. You'll only have 
these items in addition in the disk tabs : 
- Use IOCTL : Tells WinImage to use 32 bit IOCTL operations (except for format DMF, which is not 
affected by this checkbox). Normally, it's checked. 
 
- Use new DMF format technology : If it's unchecked, WinImage formats DMF in the same way as in 
version 2.20. If it's checked, it uses new code. 
 
- Quick format in 1.44 MB before DMF : If it's checked, WinImage does a quick format in 1.44 MB before 
formatting in DMF. It seems to be difficult to format a blank floppy in DMF without formatting first for 1.44 
MB.
For more info on DMF, see the DMF section.

Preference
Sets WinImage Options

Youll see this dialog box:



Ignore unused track when reading : if this option is checked, when reading (or comparing) a floppy which 
isn't full, WinImage ignores the unused tracks.

Ignore unused track when writing : if this option is checked, when writing an image to a floppy which isn't 
full, WinImage ignores the unused tracks.

Verify writing : if this option is checked, WinImage verifies after writing to a floppy. That takes more time, 
but you are sure the new disk is readable.

Use only standard format : if this option is checked, WinImage creates only standard floppies (which don't
need FDREAD).

Select floppy for image : if this option is checked, WinImage selects a floppy type for the image in 
memory. (If you load a 360Ko image, WinImage selects a 5"1/2 floppy format).

Truncate unused image part : if this option is checked, WinImage reduces the size of the image when 
writing an image file which isn't full.

Use incremented open/save wizard : if this option is checked, WinImage increments the filename by 1: 
After opening (or saving) the "DISK01.IMA" file, WinImage proposes "DISK02.IMA" for the next opening 
(or saving).

Path : Here you specify where to get the files to form the image.

These three options are for extracting subdirectories (when directories are in a selection when extracting, 
or if there is no selection) :

Ignore subdirectories : WinImage won't extract the subdirectory(~es) selected.

Extract all in the same directory : WinImage extracts all the files in a subdirectory of the image in the Path 
location.



Extract with pathname : WinImage extracts files from a subdirectory of the image to a subdirectory of the 
Path location.

Default viewer: defines the viewer application launched when double-clicking on a file without association.

Confirmation

Inject: The 2 first options allow you to enable/disable the use of a dialog box when injecting files. The third
asks for confirmation when you replace files.

Extract: The first three options control the display of a confirmation dialog box when extracting files.

Confirm overwriting when extracting: if this option is checked, if extracting risks overwriting a file, 
WinImage asks for confirmation.

When deleting files: this option controls the display of a confirmation dialog box when deleting files on 
image.

Options for registered user: see Registering.

Verify disk content before writing : if this option is checked, WinImage asks for confirmation before writing 
to a disk which contains data.

Sound and notification
Select sound and message

With this option, you can ask WinImage to play a sound (beep or, with a sound adapter, .WAV, .MID, and 
under Windows NT or 95, .AVI files).





Batch assistant

With the batch assistant, you can chain operation on several images. By selecting "Batch assistant" in the
file menu, youll see:

When WinImage executes a batch, it repeats the sequence of : making an image in memory (source), 
and using this image for saving (destination). When the source has no image, the batch is complete.

You must select one of the following sources:
- Set of floppies : WinImage will read some floppies. You tell WinImage how many floppies you want it 
to read.
- Set of images files : WinImage will load some images. You can open a list file (.WIL), or add some 
images.
- Directory injecting : WinImage will inject directories into an image. If the directory name contains a 
number, it can increment the directory name, and make an image for each directory. If a directory is 
bigger than an image, WinImage makes several images.

You must select one, or more, destinations:
- Set of floppies : WinImage will write some floppies. You tell WinImage if you want it to format them.
- Set of image files : WinImage will write some images. You specify the filename of the first, and 
WinImage increments the subsequent filenames. You can optionally make a list file (.WIL) with a 
comment.
- file extraction : WinImage will extract files from an image to directories that you specify. It can also 
increment the directory name.

In this sample, WinImage extracts the file images DISK1.IMA through to DISK5.IMA to directories c:\temp\
disk1 through to c:\temp\disk5.



Evolution of WinImage

September 1996 : Version 3.00
- Adds ZIP compatible compressed image file (.IMZ and .WLZ)
- Adds comment to compressed image file
- Adds the drag and drop from WinImage to Windows 95/Windows NT 4.0 Explorer for file extraction
- When you drag a file into WinImage without opening an image, WinImage will automatically display the 
"New" dialog box
- WinImage can copy MacIntosh 1.44 MB floppies, but it cannot view the files in the image
- Under Wintows NT, WinImage can build CD-ROM ISO compatible images

April 1996 : Version 2.50
- Support of the new ListView control and tabbed dialog boxes for settings under Windows NT 3.5x, 
Windows 95 and Win32s 1.30
- Open an ISO CD-ROM image in read-only
- Fixed bug to format DMF under Windows 95

September 1995 : Version 2.20
- Support for Win32s for 32 bit Intel version under Windows 3.1x
- Formats a blank disk without creating a new image
- Fixed bug to format and write DMF under Windows 95 and Windows NT 3.5x

June 1995: Version 2.10
- Windows 95 compatibility
- Support of Microsoft DMF - 1.68 Mb floppy

January 1994: Version 2.00
- Batch assistant
- Show disk directory when reading
- WinImage can be iconised when reading or writing a floppy
- New toolbar
- Image information
- Title bar
- Sound notification
- Support for .DLL resources (for languages other than French or English)

September 1993: Version 1.11
- Support of directory drag from Windows File Manager.

September 1993: Version 1.10
main differences:
- Windows NT version: built for the released version of NT, drag and drop server run correctly.
- Functions for deleting files in an image, changing format and defragmenting.
- Drag server of image file.
- Better usability: new menu, news option and confirmation dialog boxes, "Always on top" in system 
menu, last 4 files in File menu, help on toolbar via button.
- Incremented filename.
- Better support of comparing and option saving.



May 1993 : Version 1.0
First version.

I plan on writing a WinImage self-extractor to allow creating a Win32 EXE file which will recreate or 
extract files from an embedded image. A WinImage SDK with functions to create an image, read/write it 
on file or floppy, inject/extract, etc., is also planned. Please send me email if you think this project could 
be useful to you. A professionnal version of WinImage is also planned. It will contain the self-extractor, 
SDK, a print/export directory function, and other advanced features.

There are two versions of WinImage: a 16 bit version for Windows 3.1 (WINIMA16.EXE) and a 32 bit 
version for Windows NT (WINIMAGE.EXE). Background reading or writing disks using WINIMAGE.EXE 
will ABSOLUTELY NOT degrade application performance under Windows NT or Windows 95 (with the 
exception of operations with the DMF format under Windows 95). Note: in previous version, 
WINIMAGE.EXE was the 16 bits version and WINIMANT.EXE was the 32 bits.

There are Intel 80x86, MIPS R4000, PowerPC, and DEC Alpha versions of WinImage NT. Im interested in
receiving feedback from users of the RISC version.

There are English, French, German, Italian, Portuguese and Spanish (Swedish, Dutch, and perhaps 
Russian probably soon) versions of WinImage. If you would like to provide translations of WinImage or 
the documentation in another language, please contact me.

WINIMAGE.EXE (the Win32 version of WinImage) uses WIM16T95.DLL and WIM32T95.DLL under 
Windows 95, and WIM1632S.DLL under Windows 3.1x + Win32s 1.30. The file HLR20A16.EXE, 
distributed in some beta releases, is no longer used.

The next version of WinImage will be available only in Win32, support for Windows 3.1 will be provided 
only through Win32s (ftp://ftp.microsoft.com/softlib/MSLFILES/PW1118.EXE).

I hope you will send me feedback about WinImage. My CompuServe ID is 100144,2636 and my Internet 
e-mail box is 100144.2636@compuserve.com.

If you find WinImage useful, give it to your friend and upload it to your BBS.
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Where to find WinImage

You can find the latest version of WinImage :
- On the WinImage web site, http://ourworld.compuserve.com/homepages/gvollant/winimage.htm
- On the French BBS at (33-1) 49.60.10.70 (login and password : WinImage)
- On CompuServe, in the WUGNET (library disk/disk util), and WINFR (library disk/disk util and utility NT) 
forums

You will find these files : (xx is the version number, for example, WINIMA30.ZIP is a ZIP for version 3.00) :
- WINIMAxx.ZIP : English help and executable files for Windows 95/NT Intel and Windows 3.1 + Win32s 
1.30 (win32)
- WIMA1630.ZIP : English help and executable files for Windows 3.1 (Win16). The 3.00 is definitely the 
last Win16 version
- WIMAXPxx.ZIP : English help and executable files for Windows NT Dec Alpha
- WIMAMPxx.ZIP : English help and executable files for Windows NT Mips R4000
- WIMAPPxx.ZIP : English help and executable files for Windows NT PowerPC

- WIMAFRxx.ZIP : French help and resource files.
- WIMADExx.ZIP : German help and resource files.
- WIMAESxx.ZIP : Spain help and resource files.
- WIMAITxx.ZIP : Italian help and resource files.
- WIMAPTxx.ZIP : Portuguese help and resource files.

For example, a French user of WinImage 3.0 under Windows 95 will download WINIMA30.ZIP and 
WIMAFR30.ZIP and unzip them in the same directory.



Registering

WinImage is a shareware product, you may copy, distribute, and try it, but if you use it after the evaluation
period, you must register. You will receive a license, a registration code and the latest release.

If you register WinImage, I will send you a registering number. You can choose Registering in the Option 
menu, and enter the code. Then, you can ask to hide the first screen in the Preference (Option menu).

The licence price is now 150 French francs or $30.00 (US).

send a check (French francs or US$) to :

Gilles Vollant
13, rue François Mansart
91540 Mennecy
France

Fax : (33) (1) 64 99 94 55

Site Licence : You can contact WindowShare B.P. 2075 / 57051 Metz cedex 2 France, Fax : (33) 87 32 37
75 

You can use the CompuServe shareware registration service (GO SWREG). The WinImage registration 
number is 1233.
You can register by internet. Connect the http://ourworld.compuserve.com/homepages/gvollant/order.htm

Credit Card Ordering:
To order by MasterCard, Visa, American Express, or Discover, call the Public (software) Library at 1-800-
2424-PsL or 1-713-524-6394 or send your order by FAX to 1-713-524-6398 (U.S.A. phone number) or by 
CompuServe Email to 71355,470. You can also mail credit card orders to PsL at P.O. Box 35705, 
Houston, TX 77235-5705. Youll need to provide the cardholder's name exactly as it appears on the 
customer's credit card, plus the billing address for the card. PsL's office hours are 7:00 am to 6:00 PM 
CST Monday-Thursday and 7:00 am to 12:30 PM CST Fridays. You can give your internet address if you 
have one.
The WinImage number on the PsL registration service is #10976.

Use these numbers only for Credit Card orders. For site licenses or WinImage information, contact me at 
CompuServe 100144,2636.

This software is produced by a member of the Association of Shareware Professionals (ASP). ASP wants 
to make sure that the shareware principle works for you. If you are unable to resolve a shareware-related 
problem with an ASP member by contacting the member directly, ASP may be able to help. The ASP 
Ombudsman can help you resolve a dispute or problem with an ASP member, but does not provide 
technical support for members' products. Please write to the ASP Ombudsman at 545 Grover Road, 
Muskegon, MI 49442-9427 USA, FAX 616-788-2765 or send a CompuServe message via CompuServe 
Mail to ASP Ombudsman 70007,3536.



Japanese customers may contact P&A Shareware Co, Ltd., of Japan 302 Bellwins, 1367-23, Nakagami, 
Akishima, Tokyo, 196, Japan Phone: 0425-46-9141 / Fax: 0425-46-9142 (NIFTY : PAF02461, internet 
email:PAF02461@niftyserve.or.jp). You can visit web page http://www.pandasw.com




